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Stratasys J5 GrabCAD Print User Manual

Overview

Voxel printing enables the fabrication of many different parts with complex material distribution, such as a gradient
or a sophisticated pattern. In a program, such as Matlab, you slice the model and generate a stack of BMPs or
PNGs. Each slice contains the voxel information.
After processing these files in the Stratasys Voxel Print Utility, you import the generated GrabCAD voxel file (*.gcvf
file) into GrabCAD Print for printing.
This guide provides instructions for voxel printing with GrabCAD Print on Stratasys J7, J8 and J5 series 3D
printers.

Overview

Voxel printing enables the fabrication of many different parts with complex material distribution, such as a gradient
or a sophisticated pattern.
In a program, such as Matlab, you slice the model and generate a stack of BMPs or PNGs. Each slice contains
the voxel information.
After processing these files in the Stratasys Voxel Print Utility, you import the generated GrabCAD voxel file (*.gcvf
file) into GrabCAD Print for printing
This guide provides instructions for voxel printing with GrabCAD Print on Stratasys J7, J8 and J5 series 3D
printers.

Important:

Verify that the computer workstation you use to send the information to the printer has the minimum requirements,
as described in the relevant Site Preparation Guide.

Revision History

Translations of this guide are updated periodically. If you are consuming a translated version, please check the
English version for the latest revision and list of updates.



Revision Release date Description

 

G

 

June 2021

•        Replaced J55 with J5 series throughout the guide.

•        Removed the confidentiality statement from the guide.

Slice Preparation Guidelines

When preparing the slices (BMPs or PNGs files), consider the following guidelines:

The number of slices for each material must be

Make sure that you prepared one BMP/PNG for each If a certain material is not used in a specific slice, create

an empty BMP/PNG file (blank) for it.

It is recommended that the layer thickness of the slices you prepare match the printer layer Printer layer

thickness is, as follows:

J5 series—0.01875 mm

J7 and J8 series—

014 mm (in High Quality mode)

027 mm (in High Speed & High Mix modes)

When printing the slices, if the slice thickness does not match the printer layer thickness, the printer compensates
for the difference. This may include repeating or skipping of slices. For example, if you set the slice thickness to
0.0135 mm, and your printing mode is High Mix, the printer prints each image twice to reach the desired thickness
of 0.027 mm.

When assigning colors to your model, it is recommended that you use the RGB values of the PolyJet base

Below is the list of RGB values of PolyJet base materials.\

Color Red Blue Green

Cyan 0 89 158

Magenta 161 35 99

Yellow 213 178 0

Black 30 30 30

White 220 222 216

Generating a GrabCAD Voxel File from PNGs



After preparing the PNG file, you need to process it in the Voxel Print Utility in GrabCAD Print. This utility
generates a GrabCAD voxel file (*.gcvf file) that you import into GrabCAD Print for printing.

To generate GrabCAD voxel files from PNG files:

1. Open GrabCAD

2. From the Apps menu, select Launch Voxel Print Utility.

Important: Slicing Parameters for J5-Series Printers

Slice resolution = 300 x 300 DPI

Slice thickness = 01875 mm

From the Tools menu, select Insert PNG.



In the Slice file prefix field, enter a prefix for the image files, such as ‘slice_’. This prefix is assigned to all image
files.

Click Select and navigate to the folder that contains the PNG

Select the folder where the files PNG are

The location of the files, the path to the GCVF file, and all relevant slice information appear in the screen.



Click Next.

A progress bar shows the progress of the *.gcvf file generation

When the *.gcvf file generation is complete, the Material Mapping screen appears. The colors on the right side are
the base colors that the Voxel Print Utility identified in the PNG files. To ensure color accuracy when printing the
model on the PolyJet 3D printer, you need to match each of the colors on the right with a suitable PolyJet Model
material (left side). For example, the blue color on the right side could be mapped to VeroBlue or VeroCyan



In the Materials column, select each PolyJet Model material you want to use based on the color shown on the
right side of the screen
Before printing, make sure that the Model materials that you assigned are loaded in the material cabinet.

Click Finish.The following message
When the following message appears, click OK.

Close the Voxel Printing

To print the voxel file, continue with “Printing a Voxel Print Job” on page 19

Creating a GrabCAD Voxel File from BMPs

To generate a GrabCAD voxel file from a BMP file, you first need to create a voxel configuration file.

Preparing a Voxel Configuration Text File for BMPs

When printing BMP slices, you need to create a voxel configuration text file. You do this in a text editor, such as
Notepad. Below is a sample of a voxel configuration text file.



Important:

The bitmap files need to be 1-bit (binary) BMP

BMP LUT 0 for voxels in which the current material is not

BMP LUT 1 for voxels in which the current material is

The BMP files should be named by their The exact material name does not matter, since the exact material

names are specified in the text file.

BMP files are not required for the Support material GrabCAD Print calculates where Support material is

needed.

Save the BMP files and the voxel configuration text file on the host computer, not on the printer

The number of resins and materials listed in the text file depends on your For example for J5 series, you will

have 5 resins and materials listed.

Follow the instructions in this section to create the voxel configuration text file accurately.

To create a voxel configuration text file:

In the text file, list the parameters as follows:

Build section—



Parameters in File Definition / Instruction

 

 

[Build]

This is a section header for the following parameters.

Do not add a semi colon ( ;) at the end of the header.

Format version = 1; Keep this value as ‘1’.

Build Mode = x; Set the values to ‘3’.

 

Layer thickness = 0.0xx;
Set the layer thickness that you used to slice the mode
l (see “Slice Preparation Guidelines” on page 5).

 

 

Number of slices = xxx;

Set the total number of slices for each material (see N
ote below).

Important: GrabCAD Print crashes if this number is n
ot correct.

Number of Slices:

To determine the total number of slices, open the folder where the slices are located, and check the number of the
last slice. If the first slice is ‘0’, you need to add 1 to the number of the last slice. For example, if the first slice is
slice_0.png and the last slice is slice_2124.png, enter 2125 in the field, as shown below.

 Resin Type section—for J5 seriesv



Parameters in File Definition / Instruction

 

 

[Resin Type]

This is a section header for the list of material names i
n the printer.

Do not add a semi colon ( ;) at the end of the header.

Support = FullCure705; Set the Support material name.

Color = <Model material1 name>; Set the name of a material loaded.

Resin2 = <Model material2 name>; Set the name of a material loaded.

Resin3 = <Model material3 name>; Set the name of a material loaded.

Resin4 = <Model material3 name>; Set the name of a material loaded.

Resin5 = <Model material3 name>; Set the name of a material loaded.

 Resin Type section—for J7 and J8 series

In High Speed mode, where there are only 3 Model materials are used for printing:



Parameters in File Definition / Instruction

 

 

[Resin Type]

This is a section header for the list of material names i
n the printer.

Do not add a semi colon ( ;) at the end of the header.

Support = FullCure705; Set the Support material name.

Color = <Model material1 name>; Set the name of a material loaded.

Resin2 = <Model material2 name>; Set the name of a material loaded.

Resin3 = <Model material3 name>; Set the name of a material loaded.

In High Quality and High Mix modes, where there are 6 materials loaded:



Parameters in File Definition / Instruction

 

 

[Resin Type]

This is a section header for the following list of material
names in the printer.

Do not add a semi colon ( ;) at the end of the header.

Support = FullCure705; Set the Support material name.

Color = <Model material1 name>; Set the name of a material loaded.

Resin2 = <Model material2 name>; Set the name of a material loaded.

Resin3 = <Model material3 name>; Set the name of a material loaded.

Resin4 = <Model material4 name>; Set the name of a material loaded.

Resin5 = <Model material5 name>; Set the name of a material loaded.

Resin6 = <Model material6 name>; Set the name of a material loaded.

Resin7 = <Model material6 name>; Set the name of a material loaded. (For J8 printers onl
y.)

Important:

<Model material name> represents the name of the model material loaded in the material The material names

need to be listed exactly as they appear in the Stratasys software (not as they appear on the cartridge).

For example, if the material name in the software is VeroMgnt, and on the cartridge it is VeroMagenta enter
VeroMgnt in the text file.

In the Resin Type section, make sure that you list the model materials in the order they are loaded in the

material cabinet

Even if the job requires only some of the model materials loaded in the material cabinet:

when printing in High Speed mode, list only the names of the 3 model materials you are using for

when printing in High Mix or High Quality mode, list the names of all 6 model materials



Materials section—for J5 series

Parameters in File Definition / Instruction

 

 

[Materials]

This is a section header. In this section you provide th
e paths to the bitmaps of each of the materials (resins)
in the order listed above.

Do not add a semi colon ( ;) at the end of the header.

Material1 = C:\<path to color bmp>\<material1 filename>_xxxx.bmp

Material2 = C:\<path to color bmp>\<material2 filename>_xxxx.bmp

Material3 = C:\<path to color bmp>\<material3 filename>_xxxx.bmp

Material4 = C:\<path to color bmp>\<material3 filename>_xxxx.bmp

Material5 = C:\<path to color bmp>\<material3 filename>_xxxx.bmp

Materials section—for J7 and J8 series

In High Speed mode, where there are only 3 materials are used for printing

Parameters in File Definition / Instruction

 

 

[Materials]

This is a section header. In this section you provide th
e paths to the bitmaps of each of the materials (resins)
in the order listed above.

Do not add a semi colon ( ;) at the end of the header.

Material1 = C:\<path to color bmp>\<material1 filename>_xxxx.bmp

Material2 = C:\<path to color bmp>\<material2 filename>_xxxx.bmp

Material3 = C:\<path to color bmp>\<material3 filename>_xxxx.bmp

In High Quality and High Mix modes, where there are 6 materials loaded:



Parameters in File Definition / Instruction

 

 

[Materials]

This is a section header. In this section you provide th
e paths to the bitmaps of each of the materials (resins)
in the order listed above.

Do not add a semi colon ( ;) at the end of the header.

Material1 = C:\<path to color bmp>\<material1 filename>_xxxx.bmp

Material2 = C:\<path to color bmp>\<material2 filename>_xxxx.bmp

Material3 = C:\<path to color bmp>\<material3 filename>_xxxx.bmp

Material4 = C:\<path to color bmp>\<material4 filename>_xxxx.bmp

Material5 = C:\<path to color bmp>\<material5 filename>_xxxx.bmp

Material6 = C:\<path to color bmp>\<material6 filename>_xxxx.bmp

Material7 = C:\<path to color bmp>\<material6 filename>_xxxx.bmp

(For J8 printers only.)

Make sure that the path to the BMP files correspond to the order in which the materials are listed in the Resin

Type

For example, if material1 is VeroCyan, the path should be to the cyan BMP files.

These represent the number of digits in the bitmap filenames. If you use four digits in the bitmap filename,

include four ‘x’s in the material If you use five digits in the bitmap filename, include five ‘x’s in the material

definitions.

The ‘x’s in the material definition must be in lower-case.

Generating a GrabCAD Voxel File from BMPs

After preparing the BMP file and TXT file, you need to process them in the Voxel Print Utility in GrabCAD Print.
This utility generates a GrabCAD voxel file (*.gcvf file) that you import into GrabCAD Print for printing.

To generate GrabCAD voxel files from BMP files:

1. Open GrabCAD

2. From the Apps menu, select Launch Voxel Print Utility.



The Voxel Print Utility opens.

Important: Slicing Parameters for J5-Series Printers

Slice resolution = 300 x 300 DPI

Slice thickness = 01875 mm

From the Tools menu, select Insert BMP



1. In the Pff params area:

1. Click Select and navigate to the folder that contains the BMP

Select the voxel configuration text file ( *.txt file) you created (see “Slice Preparation Guidelines” on page 5).

In the GCVF output file name field, enter the desired location and name of the generated *.gcvf file

Click Next.

A progress bar shows the progress of the *.gcvf file generation

The file generation can take a few minutes, depending on the size of the file.

When done, the following message appears.



1. Click OK to close the

2. Close the Voxel Printing

3. To print the voxel file, continue with “Printing a Voxel Print Job” on page 19

Printing a Voxel Print Job

To print a voxel print job:From the File menu, select Add Models.

1. Navigate to the location of the *.gcvf file you generated, select it, and click Open.



GrabCAD Print validates the file and loads it.



Click Print to send the file to

c-support@stratasys.com

Copyright © 2017-2021 Stratasys Ltd. All rights reserved. DOC-08421 Rev. G
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